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Edition notice

Edition: November 2003

© 2003 Lexmark International, Inc.

All rights reserved.

UNITED STATES GOVERNMENT RIGHTS

This software and any accompanying documentation provided
under this agreement are commercial computer software and
documentation developed exclusively at private expense.

Trademarks

Lexmark is a trademark of Lexmark International, Inc., registered in
the United States and/or other countries.

PictureGrade is a trademark of Lexmark International, Inc.
PCL®isa registered trademark of the Hewlett-Packard Company.
PCL is Hewlett-Packard Company’s designation of a set of printer
commands (language) and functions included in its printer
products. This printer is intended to be compatible with the PCL
language. This means the printer recognizes PCL commands used
in various application programs, and that the printer emulates the
functions corresponding to the commands.

PostScript® is a registered trademark of Adobe Systems
Incorporated. PostScript 3 is Adobe Systems’ designation of a set
of printer commands (language) and functions included in its

software products. This printer is intended to be compatible with the
PostScript 3 language. This means the printer recognizes
PostScript 3 commands used in various application programs, and
that the printer emulates the functions corresponding to the
commands.

Other trademarks are the property of their respective owners.

Licensing notice

The printer resident software contains:
e Software developed and copyrighted by Lexmark
« Lexmark modified software licensed under the provisions of
the GNU General Public License version 2 and the GNU
Lesser General Public License version 2.1
e Software licensed under the BSD license and warranty
statements
Click the title of the document you want to review:

-’ BSD License and Warranty statements

-’ GNU General Public License

The Lexmark modified GNU licensed software is free software; you
can redistribute it and/or modify it under the terms of the licenses
referenced above. These licenses do not provide you any rights to
the Lexmark copyrighted software in this printer.

Since the GNU licensed software that the Lexmark modifications
are based upon is supplied explicitly without warranty, use of the
Lexmark modified version is similarly provided without warranty.
See the warranty disclaimers in the referenced licenses for
additional details.

Notices



Safety information

¢ If your product is not marked with this symbol @ , it must be
connected to an electrical outlet that is properly grounded.
CAUTION: Do not set up this product or make any electrical
or cabling connections, such as the power cord or telephone,
during a lightning storm.

* The power cord must be connected to an electrical outlet that
is near the product and easily accessible.

« Refer service or repairs, other than those described in the
operating instructions, to a professional service person.

* This product is designed, tested, and approved to meet strict
global safety standards with the use of specific Lexmark
components. The safety features of some parts may not
always be obvious. Lexmark is not responsible for the use of
other replacement parts.

« Your product uses a laser.

CAUTION: Use of controls or adjustments or performance of
procedures other than those specified herein may result in
hazardous radiation exposure.

* Your product uses a printing process that heats the print
media, and the heat may cause the media to release
emissions. You must understand the section in your
operating instructions that discusses the guidelines for
selecting print media to avoid the possibility of harmful
emissions.

Laser notice

The printer is certified in the U.S. to conform to the requirements of
DHHS 21 CFR Subchapter J for Class | (1) laser products, and
elsewhere is certified as a Class | laser product conforming to the
requirements of IEC 60825-1.

Class | laser products are not considered to be hazardous. The
printer contains internally a Class llIb (3b) laser that is nominally a
5 milliwatt gallium arsenide laser operating in the wavelength region
of 770-795 nanometers. The laser system and printer are designed
so there is never any human access to laser radiation above a
Class | level during normal operation, user maintenance, or
prescribed service condition.

The United Kingdom
Telecommunications Act 1984
This apparatus is approved under the approval number

NS/G/1234/3/100003 for the indirect connections to the public
telecommunications systems in the United Kingdom.

Conventions

Note: A note identifies something that could help you.

CAUTION: A caution identifies something that could cause you
harm.

Warning: A warning identifies something that could damage your
product hardware or software.

Electronic emission notices

Federal Communications Commission (FCC)
compliance information statement

This printer, type 4505, 4546, or 4547, has been tested and found
to comply with the limits for a Class B digital device, pursuant to
Part 15 of the FCC Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful interference, and
(2) this device must accept any interference received, including
interference that may cause undesired operation.
The FCC Class B limits are designed to provide reasonable
protection against harmful interference in a residential installation.
This equipment generates, uses, and can radiate radio frequency
energy and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio
communications. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the
following measures:
« Reorient or relocate the receiving antenna.
¢ Increase the separation between the equipment and
receiver.
» Connect the equipment into an outlet on a circuit different
from that to which the receiver is connected.
¢ Consult your point of purchase or service representative for
additional suggestions.
The manufacturer is not responsible for any radio or television
interference caused by using other than recommended cables or by
unauthorized changes or modifications to this equipment.
Unauthorized changes or modifications could void the user's
authority to operate this equipment.
Note: To assure compliance with FCC regulations on
electromagnetic interference for a Class B computing device, use a
properly shielded and grounded cable such as Lexmark part
number 1329605 for parallel attach or 12A2405 for USB attach.
Use of a substitute cable not properly shielded and grounded may
result in a violation of FCC regulations.
Any questions regarding this compliance information statement
should be directed to:
Director of Lexmark Technology & Services
Lexmark International, Inc.
740 West New Circle Road
Lexington, KY 40550
(859) 232-3000

Notices
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Industry Canada compliance statement

This Class B digital apparatus meets all requirements of the
Canadian Interference-Causing Equipment Regulations.

Avis de conformité aux normes de I'industrie du
Canada

Cet appareil numérique de la classe B respecte toutes les
exigences du Réglement sur le matériel brouilleur du Canada.

European Community (EC) directives conformity

This product is in conformity with the protection requirements of EC
Council directives 89/336/EEC and 73/23/EEC on the
approximation and harmonization of the laws of the Member States
relating to electromagnetic compatibility and safety of electrical
equipment designed for use within certain voltage limits.

A declaration of conformity with the requirements of the directives
has been signed by the Director of Manufacturing and Technical
Support, Lexmark International, S.A., Boigny, France.

This product satisfies the Class B limits of EN 55022 and safety
requirements of EN 60950.

Korean MIC statement

If your product includes the following
symbol on the regulatory label: A
the following statement is applicable to M’C

your product.

& M2 s
L Ao AEW
This equipment has undergone EMC registration as a household
product. It can be used in any area, including a residential area.

= =
= =
& g
-

& 7l7Zled 4 AY
&4

Noise emission levels

The following measurements were made in accordance with
ISO 7779 and reported in conformance with ISO 9296.

1-meter average sound pressure, dBA

51—Machine types 4505-100, 4505-200, 4546-xxx

Printing 52—Machine types 4505-300, 4505-310, 4547-xxx

Idling 30

Printer energy consumption

The following table documents the power consumption
characteristics of the printer.

Power consumption
(by Machine Type)
4505-100, 4505-300,
4505-200, 4505-310,
Mode Description 4546-XXX 4547-XXX
Printer is generating
Printing hard copy output 370 W 420 W
Printer is waiting for
Ready a print job 65 W 80 W
Power Printer is in energy
Saver saving mode 6 W 7W
Printer is plugged
into a wall outlet, but
Off switch is turned off ow ow

The power consumption levels listed in the previous table represent
time-averaged measurements. Instantaneous power draws may be
substantially higher than the average.

Power Saver

As part of the ENERGY STAR program, this printer is designed with
an energy-saving mode called Power Saver. The Power Saver
Mode is equivalent to the EPA Sleep Mode. The Power Saver Mode
saves energy by lowering power consumption during extended
periods of inactivity. The Power Saver Mode is automatically
engaged after this printer is not used for a specified period of time,
called the Power Saver Timeout. The factory default Power Saver
Timeout for this printer is 30 minutes.

By using the printer configuration menus, the Power Saver Timeout
can be modified between 1 minute and 240 minutes. Setting the
Power Saver Timeout to a low value reduces energy consumption,
but may increase the response time of the printer. Setting the Power
Saver Timeout to a high value maintains a fast response, but uses
more energy.

If the Power Saver Mode is affecting the effective use of this printer,
this mode can be disabled from the Local Printer Setup Utility (see
page 101) or, if you have a network model, from the printer's
resident Web page (see page 100).

Total energy usage

It is sometimes helpful to calculate the total printer energy usage.
Since power consumption claims are provided in power units of
Watts, the power consumption should be multiplied by the time the
printer spends in each mode in order to calculate energy usage.
The total printer energy usage is the sum of each mode's energy
usage.

Notices
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The operator panel has 5 lights and 2 buttons.

Note: The Continue button also functions as a light.

Continue

Cancel @

Ready

o

Toner Low / Replace PC Kit

Load Paper

2

Paper Jam

Error

T

* Press and release Continue @ to resume printing.
e Press and release Continue <D twice quickly to display a secondary error code.
e Press and release Cancel @ to cancel the job currently printing.

e Press and hold Cancel @ until all of the lights come on to reset the printer.

Printer overview
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What types of print media can be loaded?

Get the most out of your printer by properly loading the trays. Never mix media types within a tray.

Source ‘ Sizes Capacity” (sheets)
Tray 1 A4, A5, JIS B5, letter, | Plain paper, 60-90 g/m? » 250 paper
(250-sheet tray) legal, executive, fol|o,i Itrag)nslparenues, (16—24Tb) « 50 labels

statement, Universal® | |ab€ls « 50 transparencies
Tray 2 A4, A5, JIS B5, letter, | Plain paper, 60-163 g/m? » 550 paper
(550-sheet tray) legal, executive, f0|lo'¢ i[ratl)nslparenmes, (1643 Ib) e 50 labels

statement, Universal® | 1ab€ls « 50 transparencies
Manual feeder | A4, A5, JIS B5, letter, | Plain paper, 60-163 g/m? 1

legal, executive, folio, | transparencies, (16-43 Ib)

statement, Universal* | labels

Card stock’ « 120-163 g/m?
(16-90 Ib) Index Bristol

¢ 75-163 g/m?
(50-100 Ib) Tag

7%, 9, 10, DL, C5, B5 | Envelopes 920 g/m2 (24 b)

* Capacity for 20 Ib print media, unless otherwise noted.
T Grain short is recommended. Use rear exit for best results.
* Universal size ranges:

— Tray 1: 89-216 x 210-356 mm (3.5-8.5 x 8.27-14.0 in.)
— Tray 2: 148-216 x 210-356 mm (5.83-8.5 x 8.27-14.0 in.)
— Manual feeder: 76—216 x 127-356 mm (3.0-8.5 x 5.0-14.0 in.) (includes 3 x 5 in. cards)

Print media tasks and tips
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Where can print media be loaded in the printer?

Your printer has two standard paper sources: an automatic 250-sheet paper feeder (Tray 1) and a
single-sheet manual feeder. Use Tray 1 for most print jobs. Use the manual feeder for a single piece
of paper, transparency, envelope, paper label, card stock, or index card. You can increase paper
capacity by purchasing an optional 550-sheet drawer.

An output bin on top of the printer holds up to 150 sheets. The single-sheet rear exit provides a
straight-through paper path to help reduce curling and potential jams. This is especially useful for
specialty media, such as transparencies, envelopes, paper labels, card stock, or index cards.

150-sheet output bin

Front paper support

Front cover

Operator panel

Manual feeder

250-sheet tray

Optional 550-sheet drawer

Rear paper exit

Print media tasks and tips
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Tips on choosing the right print media

Selecting the right paper or other media reduces printing problems. For best print quality, try a
sample of the paper or other media you are considering before buying large quantities.

Paper

» For the best print quality, use 20 Ib (75 g/m?) xerographic, grain long paper.

The printer can automatically feed paper weights from 60 to 90 g/m? (16 to 24 |b bond) grain
long. Paper lighter than 60 g/m? (16 Ib) might not be stiff enough to feed properly, causing
jams. Paper heavier than 90 g/m? (24 Ib) should be fed through the optional 550-sheet tray or
the manual feeder.

* The laser printing process heats paper to high temperatures of 170°C (338°F) for non-MICR
applications. Use only paper able to withstand these temperatures without discoloring,
bleeding, or releasing hazardous emissions. Check with the manufacturer or vendor to
determine whether the paper you have chosen is acceptable for laser printers.

Preprinted forms and letterhead
» Use only forms and letterhead printed using an offset lithographic or engraved printing
process.
* Choose papers that absorb ink, but do not bleed.
* Avoid papers with rough or heavily textured surfaces.

Use papers printed with heat-resistant inks designed for use in xerographic copiers. The ink must
withstand temperatures of 170°C (338°F) without melting or releasing hazardous emissions. Use
inks that are not affected by the resin in toner. Inks that are oxidation-set or oil-based should meet
these requirements; latex inks might not. If you are in doubt, contact your paper supplier.

Preprinted papers such as letterhead must be able to withstand temperatures up to 170°C (338°F)
without melting or releasing hazardous emissions.

Transparencies

» Use transparencies designed specifically for laser printers. Transparencies must be able to
withstand temperatures of 170°C (338°F) without melting, discoloring, offsetting, or releasing
hazardous emissions.

* To prevent print quality problems, avoid getting fingerprints on the transparencies.

Envelopes

« Use envelopes made from 24 Ib (90 g/m?) bond paper.

* Do not use envelopes that:

Print media tasks and tips
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— Have excessive curl

— Are stuck together

— Are damaged in any way

— Contain windows, holes, perforations, cutouts, or embossments

— Use metal clasps, string ties, or metal folding bars

— Have postage stamps attached

— Have any exposed adhesive when the flap is in the sealed position

« Use envelopes that can withstand temperatures of 170°C (338°F) without:

— sealing

— excessive curling

— wrinkling

— releasing hazardous emissions

If you have any doubts about the envelopes you are considering using, check with the
envelope supplier.

e A combination of high humidity (over 60%) and the high printing temperatures may seal the
envelopes.

Labels

» Do not use labels that have exposed adhesive on the sheets.
* Do not print a large number of labels continuously.
e Do not use vinyl labels.

» Use labels that can withstand temperatures of 170°C (338°F) without sealing, excessive
curling, wrinkling, or releasing hazardous emissions. Label adhesives, face sheet (printable
stock), and topcoats must also be able to withstand 25 pounds per square inch (psi)

(172 kilopascals) pressure.

Print media tasks and tips
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Card stock

* Preprinting, perforation, and creasing can significantly affect the print quality and cause
media handling or jamming problems.

» Avoid using card stock that may release hazardous emissions when heated.

* Do not use preprinted card stock manufactured with chemicals that may contaminate the
printer. Preprinting introduces semi-liquid and volatile components into the printer.

e Use card stock with a maximum weight of 163 g/m? and a minimum size of 76 x 127 mm
(3x5in.).

Tips on storing print media and supplies

Storing paper

Use the following guidelines to avoid paper feeding problems and uneven print quality.

» Store paper in an environment where the temperature is approximately 21°C (70°F) and the
relative humidity is 40%.

» Store cartons of paper on a pallet or shelf rather than directly on the floor.

« If you store individual packages of paper out of the original carton, make sure they rest on a
flat surface so the edges do not buckle, curl, or become damaged.

* Do not place anything on top of paper packages.

Storing supplies

Choose a cool, clean storage area for your printer supplies. Store supplies right side up in their
original packaging until you are ready to use them.

Do not expose supplies to:

e Direct sunlight

e Temperatures above 35°C (95°F)
¢ High humidity (above 80%)

e Salty air

e Corrosive gases

e Heavy dust

Print media tasks and tips
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Tips on preventing jams

You can avoid most paper jams by correctly loading paper and specialty media in the printer.

The following hints can help you avoid paper jams:

Do not load wrinkled, creased, or damp paper.
Never mix media types within a tray.

Flex, fan, and straighten paper before you load it.

Do not exceed the maximum stack height.
Push all trays firmly into the printer after loading them.

Make sure the guides in the trays are positioned snug against the paper or specialty media.

Do not remove paper trays while a job is printing. Wait for a Load Paper D light sequence
(see “Load media” on page 59) before you remove the tray.

Before loading transparencies, fan the stack to prevent sheets from sticking together.
Do not use envelopes that:

— Have excessive curl

— Are stuck together

— Are damaged in any way

— Contain windows, holes, perforations, cutouts, or embossments

— Have metal clasps, string ties, or metal folding bars

— Have postage stamps attached

— Have any exposed adhesive when the flap is in the sealed position

Use only recommended paper.

Print media tasks and tips
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How to load the 250-sheet and 550-sheet trays

Follow these instructions to load paper in the 250-sheet tray and 550-sheet tray.

1 Remove the tray.

Note: If you are going to load legal or folio size paper, you have to extend the length of
the paper tray. See “Extending the tray for legal or folio size paper” on page 21
for instructions.

2 Prepare a stack of paper for loading by flexing or fanning it back and forth. Straighten the
edges on a level surface.

Print media tasks and tips
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3 Load the paper in the tray with the print side facing down.

Note: Load letterhead paper with the design side facing down. The top edge of the sheet
with the logo should be placed at the front of the tray.

Make sure the paper is below the max fill line on the side guides. Overloading may cause
jams.

4 Slide the two side guides and the back guide until they fit snugly against the stack of paper.

Print media tasks and tips
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5 Insert the tray.

6 Extend the paper support on the output bin.

Print media tasks and tips
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Extending the tray for legal or folio size paper

To load legal or folio size paper, you need to extend the paper tray. You should also attach the dust
cover on the back of the printer to protect the tray while it is extended.

1 Press down on the latch at the back of the tray.

2 Expand the tray until the extender locks into place.

Attaching the dust cover

The dust cover helps protect the paper
tray from the environment as well as
keep the tray from being knocked out of
position while it is extended.

Note: Not all models come
with a dust cover.

Attach the dust cover to the back of the
printer by aligning the tabs on the cover
to the holes on the printer and snap the
cover in place.

Print media tasks and tips
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How to load the manual feeder

The manual feeder is located at the front of your printer and can only feed one sheet of print media at
a time. You can use the manual feeder to make quick runs of paper types or sizes that are not
currently loaded in the paper tray.

For information on acceptable print media to use in the manual feeder, see “What types of print
media can be loaded?” on page 12. Using only the specified print media helps prevent paper jams
and print quality problems.

Note: We recommend that you send your print job to the printer prior to loading the
manual feeder. See “How to manually feed a print job” on page 28 for more
information.

To load the manual feeder:

1 Place a sheet of the selected print
media, print side facing up, at the
center of the manual feeder, but only
to the point where its leading edge
can contact the paper guides.
Otherwise, the printer will engage
the print media too soon and likely
skew the print job.

2 Adjust the paper guides to the print
media’s width.

3 Hold both sides of the print media
close to the manual feeder and push
it into the printer until it automatically
engages.

There is a brief pause between the
time the printer engages the print
media and when it feeds into the
printer.

Warning: Do not force the print media into the feeder. Forcing the media causes jams.

* Insert envelopes with the flap side down and with the stamp area as shown.

* Hold transparencies by the edges and avoid touching the print side. Oil from your fingers can
affect print quality.

* Load letterhead face-up, with the top of the sheet first.

* If you experience problems with paper feed, turn the paper over.

Print media tasks and tips
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How to use the rear exit

The single-sheet rear exit provides a straight-through paper path to help reduce curling and potential
jams. This is especially useful for specialty media, such as transparencies, envelopes, labels, card
stock, or index cards.

To use the rear exit, simply open the rear exit door. When the rear exit door is open, all print media
comes out the rear exit. When closed, all media is sent to the output bin on top of the printer.

Print media tasks and tips
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How to clear paper jams

When a paper jam occurs, the printer stops and the operator panel’'s Paper Jam y\r and

Continue @ lights come on. Press and release Continue <D twice quickly to display the specific
secondary error paper jam light sequence. See “Secondary error codes” on page 67 for more
information.

We recommend that you clear the entire paper path when a paper jam occurs.

To clear a paper jam:

1 |If you are feeding paper from a tray, remove the tray, and then remove any jams.

Print media tasks and tips
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2 Open the front cover and remove the print cartridge assembly.

Warning: Do not leave the print cartridge assembly exposed to direct light for an extended
period of time. Extended light exposure can cause print quality problems.

3 Remove any jams in the area behind the print cartridge assembly.
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4 Lift the flap at the front of the printer and remove any jams beneath the flap.

6 After you have cleared the jams, reinstall the print cartridge assembly, make sure all printer

covers and trays are closed, and then press Continue <D to resume printing.

Note: The printer reprints the pages that caused the paper jam.
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How to manually feed a print job

The manual feeder is located at the front of your printer and can only feed one sheet of print media at
a time. For information on acceptable print media to use in the manual feeder, see “What types of
print media can be loaded?” on page 12.

When using the manual feeder, send the print job to the printer before loading the print media. When
the printer is ready, it will display the Load Manual Feeder light sequence, at which point you should
load the media.

To manually feed a print job:

1
2

N o o b~ W

From the computer’s software application, select File = Print.

Click Properties (or Options, Printer, or Setup, depending on the application) to view the
printer driver settings.

Click the Paper tab.

Select Manual paper from the Paper tray drop-down list.
Select the appropriate Paper size and type.

Click OK.

Click OK on the Print window to send the job to print.

The printer displays the Load Manual Feeder light sequence.

<D
©
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8 Place a sheet of the selected print media, print side facing up, at the center of the manual
feeder, but only to the point where its leading edge can contact the paper guides.

* Hold transparencies by the edges and avoid touching the print side. Oil from your fingers
can affect print quality.

* Insert envelopes with the flap side face down and with the stamp area as shown.
* Load letterhead face up, with the top of the sheet first.
* If you experience problems with paper feed, turn the paper over.

9 Adjust the paper guides to the print media’s width.

10 Hold both sides of the print media close to the manual feeder and push it into the printer until
it automatically engages.

There is a brief pause between the time the printer engages the print media and when it
feeds into the printer.

Warning: Do not force the print media into the feeder. Forcing the media causes jams.
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How to print on both sides of the paper (manual duplex)

Printing on both sides of the paper reduces printing costs.

Although you can use Tray 1 or the 550-sheet tray to print the first side of the duplex job, only use
Tray 1 to print the second side.

You can choose how you want your job duplexed: Long Edge or Short Edge.

* Long Edge means pages are bound along the long edge of the page (left edge for portrait,
top edge for landscape).

Landscape
Portrait
Back of sheet
Back of o= Front of
1 Nnext sheet 1 F 119
sheet HHHHH
T Front of
lapnd next sheet

e Short Edge means pages are bound along the short edge of the page.

Portrait

Back of sheet
Landscape

Back of sheet Front of sheet
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)
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Front of sheet

To manually duplex a print job:

1 From the computer’s software application, select File - Print.

2 Click Properties (or Options, Printer, or Setup, depending on the application) to view the
printer driver settings.

3 From the Page Layout tab, select 2-sided printing.
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Select either Long Edge or Short Edge.

Select Manual 2-sided printing.

Click the Paper tab.

Select the appropriate Input options for your print job.

Click OK.

© 00 N o o b

Click OK on the Print window.
The printer prints every other page of the document first. Once the first side of your job prints,

the Load Paper D light comes on and the Continue @ light blinks.

O N

2

O
O

10 Load the paper back into the printer with the already-printed side up and the top of the page
toward the front of the tray.

T
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How to print multiple page images on one page (N-up printing)

The Multipage Printing (N-up) setting is used to print multiple page images on a single page. For
example, 2-Up means two page images are printed on one page, 4-up means four page images are
printed on one page, and so on.

The printer uses the Multipage Order, Multipage View, and Multipage Border settings to determine
the order and orientation of the page images, and whether a border is printed around each page
image.

1 From the computer’s software application, select File - Print.

2 Click Properties (or Options, Printer, or Setup, depending on the application) to view the
printer driver settings.

3 From the Page Layout tab, select the number of images per sheet (from the Multipage
printing section) and the orientation you would like the paper to have.

The positioning depends on the number of images and whether the images are portrait or
landscape in orientation.

For example, if you select 4-Up multipage printing and portrait orientation, the results differ
depending on the Multipage Order value you select:

ACross Down

4 To print a visible border around each page image, select Print page borders.
5 Click OK.

6 Click OK on the Print window to send the job to print.
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How to print a booklet

The Booklet setting lets you print multiple pages in booklet form without having to re-format your
document so the pages print in the proper order. The pages print so that the finished collated
document may be folded along the center of each page to form a booklet.

TN
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If the document contains many pages, a booklet may have too many pages to fold easily. If you are
printing a fairly large booklet, you might want to use the Sheets per Bundle option to specify how
many physical pages are put into one bundle. The printer will print the necessary number of bundles,

which you can then bind into one booklet. Printing in bundles helps the outside edge of the pages
line up more evenly.

You must specify whether or not you want to print using any Duplex printing options before you select
to print using the booklet function. Once you choose Print Using Booklet, the controls for the Duplex
options are dimmed and remain at the last setting used.

1 From the computer’s software application, select File > Print.

2 Click Properties (or Options, Printer, or Setup, depending on the application) to view the
printer driver settings.

3 From the Page Layout tab, click More Page Layout Options.

N

Click Booklet.

If your print job is large, you may want to use the Sheets per Bundle option.
Select the appropriate binding edge for your print job.

To print a visible fold mark on the pages, select Print fold mark.

Click OK twice.

o N o O

Click OK on the Print window to send the job to print.
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How to print a poster

The Poster setting lets you print a single image across several pages. Once printed, you can
combine the pages to create one large image.

N
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From the computer’s software application, select File = Print.

Click Properties (or Options, Printer, or Setup, depending on the application) to view the
printer driver settings.

From the Page Layout tab, click More Page Layout Options.

Click Poster.

Select the poster size you want by choosing the number of pages to use in the poster.
To print crop marks on the pages, select Print crop marks.

Select the amount of overlap you want each page to have.

Click OK twice.

Click OK on the Print window to send the job to print.
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How to print on letterhead

To print on letterhead, make sure the paper is loaded with the proper orientation.

1 Make sure the letterhead is properly loaded according to the paper source you are using:

e Tray 1 or 2—Load the letterhead paper with the design side facing down. The top edge of
the sheet with the logo should be placed at the front of the tray.

* Manual feeder—Load the letterhead paper face-up, with the top of the sheet first.
Note: If you are using the manual feeder, first send the job to print, then load the
letterhead when the printer displays the Load Manual Feeder light sequence (see
“How to manually feed a print job” on page 28).

2 From the computer’s software application, select File = Print.

w

Click Properties (or Options, Printer, or Setup, depending on the application) to view the
printer driver settings.

Click the Paper tab.
Select Letterhead from the Paper type drop-down lists.
Select the appropriate paper size and tray.

Click OK.

0 N o o1 b

Click OK on the Print window to send the job to print.

How to print using an overlay or a watermark

Overlays and watermarks are templates that can be defined and then printed as a background on a
form before the data from the current job is printed. Typical examples of overlays include company
logos or letterheads, decorative borders, and simulated “preprinted” forms. Overlays can include text,
graphics, or images. Watermarks are simple text. You can create overlays and watermarks and then
download them directly to the printer, or you can create an overlay or watermark file on your system
and then download it to the printer.

Note: To create and download overlays, you must have flash memory installed.

For information about how to create, save, or download an overlay or watermark, refer to the printer
driver Help.
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Using an overlay

N
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From the computer’s software application, select File = Print.

Click Properties (or Options, Printer, or Setup, depending on the application) to view the
printer driver settings.

Click the Other Options tab.

Click Overlays.

Select which pages receive the overlay.
Select the overlay to use.

Select whether to place the overlay on top of or underneath the page image in the Overlay
placement area.

Click OK.

Using a watermark

N
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From the computer’s software application, select File &> Print.

Click Properties (or Options, Printer, or Setup, depending on the application) to view the
printer driver settings.

Click the Other Options tab.

Click Watermark.

Select which pages receive the watermark.
Select the watermark to use.

Select whether to place the watermark on top of or underneath the page image in the
Watermark placement area.

Click OK.
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How to cancel a print job

A print job can be canceled from the operator panel or from your computer. The Cancel job light
sequence is displayed on the operator panel while the job is being cancelled.

From the printer operator panel

Press and release Cancel @ to cancel the job currently printing.

From a Windows computer

1 Click Start > Settings = Printers.
2 Double-click the printer you are using to print the job.

A list of print jobs appears.

3 Right-click the document you want to stop printing, and then click Cancel.

From a Macintosh computer
When you send a job to print, the printer icon appears on the desktop.

1 Double-click the printer icon on your desktop.

A list of print jobs appears.

2 Press Control and click the print job you want to cancel. Choose Stop Queue from the
pop-up menu.
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How to access the system board
To install a memory or flash card you must access the printer system board.
CAUTION: Turn the printer off and unplug the power cord before continuing.

1 Open the front cover by pressing the button on the left side of the printer and lowering the
cover.
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2 Open the rear exit.

3 Open the side cover by pressing the two detents on the front right side of the machine and
swinging the cover back.
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4 Remove the two screws at the top and side of the metal plate covering the system board.

5 Remove the metal plate by rotating it towards the front and to the right.
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How to reattach the system board cover

When you are finished adding a memory or flash card, be sure to properly reattach the system
board’s metal cover.

1 Insert the two tabs on the right side of the metal plate into the holes toward the back of the
system board and rotate the system board until it is flush against the printer.

Screw in the two screws at the top and side of the metal plate.
Close the side cover.

Close the rear exit.

a b~ W N

Close the front cover.
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How to add a memory card

The system board has one connector for an optional memory card. The printer can support up to
64MB of additional memory (for a total of 80MB) for the base model and up to 128MB (for a total of
160MB) for the high capacity and network models.

CAUTION: If you are installing a memory card after setting up the printer, turn the printer off
and unplug the power cord before continuing.

Note: Memory options designed for other printers may not work with your printer.

1 Access the system board (see How to access the system board).

2 Push open the latches on both ends of the memory
connector.

3 Unpack the memory card. J

Warning: Memory and flash memory cards are easily
damaged by static electricity. Touch
something metal, such as the printer frame, /
before you touch a memory card.

Avoid touching the connection points along the edge of the card.

4 Align the notches on the bottom of the card with
the notches on the connector.

¢

5 Push the memory card firmly into the connector
until the latches on either end of the connector
shap into place.

19

It may require some force to fully seat the card.

6 Make sure each latch fits over the notch on each
end of the card.

e J

7 Reattach the system board cover (see How to reattach the system board cover).

8 See How to get the printer driver to recognize installed options.
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How to add a flash card

The system board has one connector for an optional flash card. The printer can support 16MB and
32MB flash cards.

CAUTION: If you are installing a flash card after setting up the printer, turn the printer off and
unplug the power cord before continuing.

Note: Flash cards designed for other printers may not work with your printer.

1 Access the system board (see How to access the system board).

2 Unpack the flash card.

Warning: Flash cards are easily damaged by static electricity. Touch something metal, such
as the printer frame, before you touch a card.

Avoid touching the metal pins on the bottom of the card.

Metal pins

N

3 Holding the card by its sides, align the pins on the card with the holes on the system board.
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4 Push the flash card firmly into place.

The entire length of the connector on the flash card must touch and be flush against the
system board.

Be careful not to damage the connectors.
5 Reattach the system board cover (see How to reattach the system board cover).

6 See How to get the printer driver to recognize installed options.
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How to install a 550-sheet drawer

Your printer supports one optional drawer that lets you load up to 550 sheets of paper.

CAUTION: If you are installing a 550-sheet drawer after setting up the printer, turn the printer
off and unplug the power cord before continuing.

1 Unpack the 550-sheet drawer and remove any packing material.
2 Place the drawer in the location you have chosen for your printer.

3 Align the holes in the printer with the positioning posts on the 550-sheet drawer and lower the
printer into place.

4 See How to get the printer driver to recognize installed options.
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How to get the printer driver to recognize installed options

After the printer is turned on, the printer driver should automatically recognize an option you
installed. If it does not, you can add it manually.

a b~ W N

Note: If you have not installed your printer driver yet, follow the appropriate instructions
under Software and network tasks. After you have installed a printer driver, return
here to complete these instructions.

Click Start > Settings > Printers.

Select the printer’s icon.

Click File > Properties.

Click the Install Options tab.

Add the appropriate options to your configuration:

* 550-Sheet Tray or Flash Card—Select the option you installed from the Available options
list and click Add.

*  Memory Card—Increase the printer memory to the appropriate number.

Click OK.
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Overview of the operator panel

The operator panel has 5 lights and 2 buttons.

Note: The Continue button also functions as a light.

Continue

Cancel @

/
1 AN

vty ——— @ -

Toner Low / Replace PC Kit

Load Paper

) e

Paper Jam

Error

TS

e Press and release Continue <D to resume printing.
e Press and release Continue @ twice quickly to display a secondary error code.
e Press and release Cancel @ to cancel the job currently printing.

e Press and hold Cancel @ until all of the lights come on to reset the printer.
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Understanding the operator panel lights

The operator panel lights mean different things, depending on their sequence. Lights that are off, on,
and/or blinking indicate printer conditions such as printer status, intervention, or service.

The following tables show the most common light sequences. Click the indicated page for more
information on what it means.

Common light sequences

<D () =0n _\<D/_<}_\ ' = Blinking Q = Slow blink Empty = Off
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Printer condition
Ready /

Power Saver

Hex Trace Ready
Waiting

Flushing /
Resolution reduced
Not ready

(printer is offline)
Close door

Load media

Load manual feeder
Print side two

of a duplex job
Invalid engine code /
Invalid network code
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Common light sequences (continued)
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* See “Secondary errors” on page 52 for more information.
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Secondary errors

e When the Error ' and Continue <D lights are both on, a secondary error has occurred.

e When the Paper Jam y\r and Continue <D lights are both on, a paper jam secondary error
has occurred.

Press and release Continue @ twice quickly to display the secondary error code light sequence.
The following table shows what these light sequences mean and where to go for help.
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Secondary Error codes
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* Paper jams at the input sensor can be either after the paper leaves the tray and enters
the printer or in the manual feeder.
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Secondary Error codes (continued)
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Operator panel codes

Below are explanations of what the primary light sequences, or codes, and secondary error codes
mean and what you can do to clear them.

Primary codes
Ready / Power Saver

Light sequence:

e Ready—On

What this light sequence means:

e The printer is ready to receive and process data.
e The printer is in Power Saver mode.

I,
m™

What you can do:
* Send a print job.

e Press Continue <D to print the menu settings pages for a
list of current printer settings.

e Press and hold Cancel @ to reset the printer.

Note: If you want to change the Power Saver setting, it
can only be set from the Local Printer Setup Utility
(see “Using the Local Printer Setup Utility” on
page 101).

0000 e
= ) e
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Busy

Light sequence:

Ready—BlIink

What this light sequence means:

The printer is busy receiving and processing data or printing.

The printer is defragmenting the flash memory to reclaim
storage space occupied by deleted resources.

The printer is formatting the flash memory.

The printer is storing resources, such as fonts or macros, in
flash memory.

The printer is printing a directory, font list, menu settings
pages, or Print Quality Test Pages.

What you can do:

Busy:
— Wait for the message to clear.

— Press and release Cancel @ to cancel the print job.

— Press and hold Cancel @ to reset the printer.

Defragmenting flash, formatting flash, or programming flash:

— Wait for the message to clear.

— Warning: Do not turn the printer off while this message is
displayed.

Printing a directory, a font list, menu settings pages, or Print

Quality Test Pages:

— Wait for the pages to print. The Busy message is
displayed as the pages print. The Ready light is on when
printing stops.

— Press and release Cancel @ to cancel printing.

— Press and hold Cancel @ to reset the printer.
Receiving/processing data from a host interface:
— Wait for the message to clear.

— Press and release Cancel @ to stop processing.

— Press and hold Cancel @ to reset the printer.
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Hex Trace Ready

Light sequence:

¢ Ready—Slow blink

What this light sequence means:

The printer is in the Ready mode and Hex Trace is active.

What you can do:

l,
™

e Advanced users can use Hex Trace to help troubleshoot
printing problems. After resolving the problem, turn off the
printer to exit Hex Trace.

N
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* Press and hold Cancel @ to reset the printer.

0000 M
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Waiting
Light sequence: ®
e Continue—On
e Ready—On

What this light sequence means: @

The printer is waiting until a print timeout occurs, or until it receives
additional data.

l
™

What you can do:

* Press Continue @ to print the contents of the print buffer.
e Press and release Cancel @ to cancel the print job.

e Press and hold Cancel @ to reset the printer.

0000 e
= ) e

Using the operator panel
57



Flushing / Resolution reduced

Light sequence:
¢ Ready—BIlink
* Error—Blink
What this light sequence means:

e The printer is flushing corrupted print data.

e The printer is processing data or printing pages, but the
resolution of a page in the current print job is reduced from
600 dots per inch (dpi) to 300 dpi to prevent a memory full

: 3
error. O
O
O

What you can do:

e Wait until the operator panel returns to Ready to print other
jobs.

* Press and release Cancel @ to cancel the print job. )

e Press and hold Cancel @ to reset the printer.

Not ready

Light sequence: <D
» Continue—On

What this light sequence means:

Q

The printer is not ready to receive or process data, or the printer
ports are offline.

l,
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What you can do:

e Press Continue @ to return to the Ready or Busy state.
e Press and release Cancel @ to cancel the print job.

e Press and hold Cancel @ to reset the printer.

0 0O0O0O0
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Close door

Light sequence:

e Error—On

What this light sequence means:

The printer door is open.

What you can do:

Close the door.

Load media

Light sequence:

e Continue—On
e Load Paper—On
What this light sequence means:

The printer is out of media, or the media did not feed properly.
What you can do:
e Load media into tray 1 or the optional 550-sheet tray and

press Continue <D to resume printing.

e Check that the media is loaded correctly in tray 1 or the
optional 550-sheet tray.

e Press Cancel @ to cancel the print job.
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Load manual feeder

Light sequence: ®
e Continue—On
e Load Paper—Blink

What this light sequence means: @

The printer prompts you to load a single sheet of media in the manual
feed.

What you can do:

* Load media, with the side to be printed facing the front of the
printer, into the manual feed.

e Press Continue @ to resume printing.

e Press and hold Cancel @ to reset the printer.

Print side two of a duplex job

Light sequence:

e Continue—Blink
e Load Paper—On

What this light sequence means:

Print the other side of your duplex print job.

l
™

What you can do: O

* Reinsert your print job in tray 1 using the instructions in the
driver pop-up menu to orient the pages correctly. Press O

Continue <D to resume printing.

) fe

e Press and hold Cancel @ to reset the printer. O

T
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Invalid engine code / Invalid network code

Light sequence:
¢ Ready—On
e Error—On
What this light sequence means:

The code in an internal print server has not been programmed, or the
programmed code is not valid.

l,
N

What you can do:

N
&)

Download valid network code to the internal print server. Press

Continue <D twice quickly to see the secondary error code. See
“Secondary error codes” on page 67 for more information.

00O e
= ) e

Toner low

Light sequence:

» Toner Low/Replace PC Kit—On

What this light sequence means:

The printer is ready to receive and process data. In addition, the
toner in the toner cartridge is getting low.

l
™

What you can do: O

e Press Continue <D to print the menu settings page for a list
of current printer settings.

* Remove the toner cartridge and shake it to extend the life of
the cartridge.

* Replace the toner cartridge. (See “How to change a toner
cartridge” on page 106 for help.)

olele
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e Press and hold Cancel @ to reset the printer.

Note: This light may not come on if the starter toner
cartridge is installed in a base printer model.
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Photoconductor kit near full

Light sequence: ®
e Continue—On

e Toner Low/Replace PC Kit—Blink

Q

What this light sequence means:

The photoconductor kit's drum is almost full and will need replacing
soon.

O

Note: The Toner Alarm (see page 101) must be turned on
for this message to appear. 3
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What you can do:

e Press Continue <D to resume printing.

* Replace the photoconductor kit. See “How to change a
photoconductor kit” on page 109 for more information.

O O O-
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Replace photoconductor kit
Light sequence:
» Toner Low/Replace PC Kit—BIlink

What this light sequence means:

The photoconductor kit's drum is full and needs replacing.

What you can do:

O

e Press Continue <D to resume printing.

« Replace the photoconductor kit. See “How to change a B /
photoconductor kit” on page 109 for more information.
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Replace photoconductor kit (printer hard stop)

Light sequence: ®
e Continue—On
e Toner Low/Replace PC Kit—Blink

e Error—Blink @

What this light sequence means:

The photoconductor kit's drum is full and needs replacing. The printer

will not print any more pages until the photoconductor kit is replaced. O <F
1
. e v
What you can do: A LL.J/
Replace the photoconductor kit. (See “How to change a
photoconductor kit” on page 109 for help.) O D

Unsupported toner cartridge / Toner cartridge is not installed

Light sequence:
» Toner Low/Replace PC Kit—On
e Error—On

What this light sequence means:

The toner cartridge is not installed, or the printer detects a toner
cartridge error.

O

What you can do:

e If the toner cartridge is not installed, install it.

« If the toner cartridge is installed, remove it and install a new
toner cartridge (see “How to change a toner cartridge” on
page 106).

O O
= ) e
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Change invalid toner cartridge

Light sequence:
» Toner Low/Replace PC Kit—On
* Error—Blink

What this light sequence means:

The toner cartridge you are using was not designed for your printer.

What you can do:

Install a toner cartridge made for your printer (see “What supplies
do I need and how do | order them?” on page 103).

Programming engine code / Programming system code

Light sequence:
¢ Ready—On
e Toner Low/Replace PC Kit—On
e Load Paper—On

What this light sequence means:

New code is being programmed into the engine or firmware code
flash.

What you can do:

Wait for the message to clear. When the printer has finished
programming the code, it performs a soft reset.

Using the operator panel
64

O

O O

fo

by o8

l/
N

= ) e

l
™

= ) e

&

&



Cancel job / Reset printer

Light sequence: ®
e Continue—On

e Ready—On
» Toner Low/Replace PC Kit—On @
e Load Paper—On

e Paper Jam—On
*  Error—On

)

What this light sequence means:

e The current print job is canceled.

R
e The printer is resetting to the user default settings. Any active
print jobs are canceled. A user default setting remains in D
effect until you change it or until you restore the factory
default settings. SJ\f

What you can do:

Wait for the message to clear.

Service error

Light sequence:

» Continue—Blink

e Ready—BIlink

e Toner Low/Replace PC Kit—Blink
e Load Paper—Blink

e Paper Jam—Blink

e Error—Blink

What this light sequence means:

, . . L) Y

The printer has a service error and printing has stopped. I LJ/
N\, 1 /

What you can do: Bl D

Turn the printer off and back on. If the lights are still blinking, contact F o g\r

the place where you bought your printer. T ¢
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Printer error

Light sequence:

¢ Continue—On
e Error—On

What this light sequence means:

The printer has one of the following errors:

* Memory is full, insufficient to save what is in the buffer, or
insufficient to defragment flash memory.

e A page is too complex to print or is shorter than the set page
margins.

* Resolution of a formatted page is reduced to 300 dpi.

» Afonterror occurred.

e Communication with the host computer is lost.

What you can do:

e Press Continue @ twice quickly to see the secondary error
code. See “Secondary error codes” on page 67 for more
information.

e Press Continue <D to clear the secondary message.

Paper jam printer error

Light sequence:

e Continue—On
e Paper Jam—On

What this light sequence means:

The printer has a paper jam.

What you can do:

e Press Continue <D twice quickly to see the secondary error
code. See “Secondary error codes” on page 67 for more
information.

* Press Continue @ to resume printing once all the jammed
pages are cleared from the paper path.
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Secondary error codes

e When the Error ' and Continue <D lights are both on, a secondary error has occurred.

e When the Paper Jam y\r and Continue <D lights are both on, a paper jam secondary error
has occurred.

Press and release Continue @ twice quickly to display the secondary error code light sequence.
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Paper jam at the input sensor

Light sequence:

e Continue—On
e Ready—On
e Paper Jam—On

What this light sequence means:

A paper jam has occurred at the input sensor, which can be either
after the paper leaves the tray and enters the printer or in the manual

feeder.

What you can do:

Clear the paper jam. See “How to clear paper jams” on page 24
for more information.

Paper jam in the manual feeder

Light sequence:

e Continue—On
* Ready—Blink
e Paper Jam—On

What this light sequence means:

A paper jam has occurred in the manual feeder.

What you can do:

Clear the paper jam. See “How to clear paper jams” on page 24
for more information.
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Paper jams as it exits the tray into the printer

Light sequence:
e Continue—On
e Toner Low/Replace PC Kit—On
e Paper Jam—On

What this light sequence means:

A paper jam has occurred as the paper is exiting the paper tray and
entering the printer.

What you can do:

Clear the paper jam. See “How to clear paper jams” on page 24
for more information.

Paper jams as a printed job exits the printer

Light sequence:
e Continue—On
e Load Paper—On
e Paper Jam—On

What this light sequence means:

A paper jam has occurred as the paper is exiting the printer.

What you can do:

Clear the paper jam. See “How to clear paper jams” on page 24
for more information.
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Paper jam in Tray 1

Light sequence:

e Continue—On

e Toner Low/Replace PC Kit—On
e Load Paper—On

e Paper Jam—On

What this light sequence means:

A paper jam has occurred in Tray 1.

What you can do:

Clear the paper jam. See “How to clear paper jams” on page 24
for more information.

Paper jam in Tray 2

Light sequence:

e Continue—On

e Ready—On

e Load Paper—On
e Paper Jam—On

What this light sequence means:

A paper jam has occurred in Tray 2.

What you can do:

Clear the paper jam. See “How to clear paper jams” on page 24
for more information.
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Complex page

Light sequence: ®
« Continue—On
e Ready—On
¢  Error—On

Q

What this light sequence means:

The page may not print correctly because the print information on the
page is too complex (that is, too large for the printer's memory).

l,
N

What you can do:

N
&)

e Press Continue <D to clear the message and continue
processing the print job (some of the print data may be lost).

¢ To avoid this error in the future:

— Reduce the complexity of the page by reducing the
amount of text or graphics on the page and deleting
unnecessary downloaded fonts or macros.

— Set Page Protect to On in the Local Printer Setup Utility.

— Install additional printer memory (see “How to add a
memory card” on page 43).

00O e
= ) e

Insufficient printer memory

Light sequence: O
¢ Continue—On
* Ready—Blink
e Error—On
What this light sequence means:
The printer does not have enough memory to save the data in the
buffer.

What you can do:

¢ Install additional memory (see “How to add a memory card”
on page 43).

OO0 0% K
) B

T

* Press Continue @ to continue printing the job.

e Press Cancel @ to cancel the print job.
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Insufficient collation area

Light sequence: @
e Continue—On
e Toner Low/Replace PC Kit—On
Error—On @

What this light sequence means:

The printer memory does not have the free space necessary to
collate the print job. This may happen due to one of these errors:

O

e Memory is full.

e A page is too complex to print.

e A page is shorter than the set page margins. O
« Memory is insufficient to save what is in the buffer.

) fe

What you can do:

O
T

e Press Continue <D to clear the message and continue
printing the job (the job may not print correctly.)

* Press and release Cancel @ to cancel the print job.

e Press and hold Cancel @ to reset the printer.
e To avoid this error in the future:

— Simplify the print job. Reduce the complexity of the page
by reducing the amount of text or graphics on the page
and deleting unnecessary downloaded fonts or macros.

— Install additional printer memory (see “How to add a
memory card” on page 43).
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Font error

Light sequence:

e Continue—On
e Toner Low/Replace PC Kit—Blink
e  Error—On

What this light sequence means:

The printer has received a request for a PPDS font which is not
installed.

What you can do:
e Press and release Cancel @ to cancel the print job.

e Press and hold Cancel @ to reset the printer.

e Press Continue @ to clear the message and continue
printing.

Defective flash

Light sequence:

* Continue—On
e Load Paper—On
e Error—On

What this light sequence means:

The printer detects defective flash memory.

What you can do:

e Press Continue @ to clear the message and continue

printing. Downloaded fonts and macros not previously stored

in flash memory are deleted.

e See “How to add a memory card” on page 43 to install
flash memory.
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Insufficient defrag memory

Light sequence:
e Continue—On
e Load Paper—Blink
Error—On

What this light sequence means:

The printer has insufficient memory to free unused space in flash
memory.

What you can do:

* Delete fonts, macros, and other data in RAM.
» Install additional printer memory.

Network interface errors

Light sequence:

¢ Continue—On
e Paper Jam—On
¢ Error—On

What this light sequence means:

The printer cannot establish communication with the network.

What you can do:

Press Continue @ to clear the message and continue printing.
(The job may not print correctly.)
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Error communicating with the host computer

Light sequence: ®
e Continue—On
e Paper Jam—Blink
Error—On

Q

What this light sequence means:

The printer has lost the connection to an external print server (also
called an external network adapter or ENA).

l,
N

This light sequence is displayed if your printer is connected to the
network, but it cannot detect the print server when you turn on the
printer.

) fe

What you can do:

-0 O O

T

* Make sure the cable connecting the ENA and the printer is e
securely attached. Turn the printer off and then on to reset the
printer.

e Press and hold Cancel @ to reset the printer.

Host interface disabled

Light sequence: Q>
» Continue—On
* Load Paper—Blink

e Paper Jam—Blink
e  Error—On @

What this light sequence means:

O

The printer USB or parallel port has been disabled.

What you can do: O [ZJ]/
N\ 1 /
e Press Continue <D to clear the message. The printer n® o D
discards any print jobs previously sent. Enable the USB or :
parallel port by selecting a value other than Disabled for the S G
USB Buffer or Parallel Buffer item in the Local Printer Setup '
Utility (see Using the Local Printer Setup Utility). '
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Memory full

Light sequence:

e Continue—On

e Ready—On

» Toner Low/Replace PC Kit—On
*  Error—On

What this light sequence means:

The printer is processing data, but the memory used to store pages
is full.

What you can do:

* Press Continue @ to clear the message and continue
printing the job (the job may not print correctly).

* Press and release Cancel @ to cancel the print job.

e Press and hold Cancel @ to reset the printer.
* To avoid this error in the future:

— Simplify the print job. Reduce the complexity of the page
by reducing the amount of text or graphics on the page
and deleting unnecessary downloaded fonts or macros.

— Install additional printer memory (see “How to add a
memory card” on page 43).
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Short paper

Light sequence: ®
e Continue—On

e Ready—On
e Load Paper—On
*  Error—On @

What this light sequence means:

The paper length is too short to print the formatted data. This occurs ‘ 2%
when the printer does not know the media size loaded in the tray, or
there is a problem feeding the media. O /

) fe

What you can do:

* Make sure the print media you loaded is large enough.

O ¥
e Open the front cover, clear the paper path and close the cover °
to resume printing (see “How to clear paper jams” on '
page 24). !

e Press Continue <D to clear the message and continue
printing the job.

e Press Cancel @ to cancel the print job.
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Flash full

Light sequence: ®
e Continue—On

e Ready—On
e Paper Jam—On
*  Error—On @

What this light sequence means:

)

There is not enough free space in the flash memory to store the data
you are trying to download.

What you can do:

O O
L B

* Delete fonts, macros, and other data stored on the flash
memory to free up space.

e Press Continue @ to clear the message and continue
printing. Downloaded fonts and macros not previously stored
in flash memory are deleted.

« Install flash memory with more storage capacity. See “How

to add a memory card” on page 43 for instructions on how
to install flash memory.

T

e Press and release Cancel @ to cancel the print job.

e Press and hold Cancel @ to reset the printer.
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Unformatted flash

Light sequence: ®
e Continue—On
e Toner Low/Replace PC Kit—On

e Paper Jam—On
*  Error—On @

What this light sequence means:

O

The printer detects unformatted flash memory.

N
&)

What you can do:

) fe

e Press Continue @ to clear the message and continue O
printing. The job may not print correctly.

e Reformat the flash memory.

e If the error message remains, the flash memory may be
defective and should be replaced.

T

Invalid engine code

Light sequence:

¢ Ready—On
e Load Paper—On
Error—On

What this light sequence means:

The code in an internal print server has not been programmed, or the
programmed code is not valid.

)
(:):_

What you can do:

O

)
Download valid engine code to the internal print server. D
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Invalid network code

Light sequence:

¢ Ready—On
e Load Paper—Blink
Error—On

What this light sequence means:

The code in an internal print server has not been programmed, or the
programmed code is not valid.

l,
™

What you can do:

Download valid network code to the internal print server.

O+4-0 @
L) B

T
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Understanding the printer configuration
menus

\V -

Section Page
Printing the Printer Settings Configuration sheet 81
Configuration menus overview 82

* Network menu 83

» Parallel menu 84

* Setup menu 84

* USB menu 85

+ Utilities menu 85

Printing the Printer Settings Configuration sheet

To help resolve printing problems or to change printer configuration settings, advanced users can
print the Printer Settings Configuration sheet for instructions on advancing through the configuration
menus to select and save new settings.

To print the Printer Settings Configuration sheet:

1 Turn off the printer.

2 Open the front cover.

3 Press and hold Continue @ as you turn the printer back on.
All the lights cycle.

4 Close the cover. The light sequence that represents the Home menu is displayed.

5 To print the Printer Settings Configuration sheet, press and hold Continue @ until the
lights cycle. The sheet prints.

Note: The sheet only prints when the Home menu is displayed.
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Configuration menus overview

Menus are represented by Ready ’\@/’ , Toner Low/Replace PC Kit LJYJJ/ , Load Paper D , and
Paper Jam :J\f light sequences. Menu items and their settings are indicated by Error ' and

Continue @ light sequences.
e Press and release Cancel @ to advance through menus and menu items.
e Press and release Continue <D to advance to the setting you need.
e Press and hold Continue @ until all of the lights cycle to save a setting.

e Press and hold Cancel @ until all of the lights cycle to return to the Home menu.

e Turn off the printer to exit the menus.
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Network menu

Use the Network menu to change printer settings on jobs sent through a network port (either
Standard Network or Network Opt <x>).

Setting Use this setting to: Values

NPA Mode Send print jobs to the printer and query |« Off
printer status information . Auto*
simultaneously.

MAC Binary PS Configure the printer to process » Off—The printer filters PostScript print jobs
Macintosh binary PostScript print jobs. using standard protocol.

* On—The printer processes raw binary
PostScript print jobs from computers using
the Macintosh operating system. This setting
often causes Windows print jobs to fail.

e Auto*—The printer processes print jobs
from computers using either Windows or
Macintosh operating systems.

Set Card Speed Automatically detect the connection e Auto*—The printer detects current network
speed of your network. You can disable speed.

this setting to set the speed manually. . 10MbpsT Half Duplex—Forces the printer

to try to connect to the network only at
10Mbps, Half Duplex.

¢ 10Mbps, Full Duplex—Forces the printer to
try to connect to the network only at 10Mbps,
Full Duplex.

* 100Mbps, Half Duplex—Forces the printer
to try to connect to the network only at
100Mbps, Half Duplex.

¢ 100Mbps, Full Duplex—Forces the printer
to try to connect to the network only at
100Mbps, Full Duplex.

* Factory default
T Megabits per second
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Parallel menu

Use the Parallel menu to change printer settings on jobs sent through a parallel port.

Setting Use this setting to: Values
NPA Mode Send print jobs to the printerand |+ Off
query printer status information e On
simultaneously. . Auto*
Protocol Receive information at a much » Standard
higher transmission rate if your . Fastbytes*
printer is set to Fastbytes (if your
computer supports Fastbytes) or
receive information at a normal
transmission rate if your printer is
set to Standard.
Parallel Mode 2 Determine whether the parallel o Off
port data is sampled on the . On*
leading (On) or trailing (Off) edge
of strobe.
MAC Binary PS Configure the printer to process » Off—The printer filters PostScript print jobs
Macintosh binary PostScript print using standard protocol.
jobs. « On—The printer processes raw binary
PostScript print jobs from computers using the
Macintosh operating system. This setting often
causes Windows print jobs to fail.
« Auto*—The printer processes print jobs from
computers using either Windows or Macintosh
operating systems.

* Factory default

Setup menu

Use the Setup menu to configure how the printer formats the end of a line depending on the
computer system being used.

Setting Use this setting to: Values

Auto CR after LF Specify whether the printer automatically performs a carriage return |« Off*
after a line feed control command. « On

Auto LF after CR Specify whether the printer automatically performs a line feed after |« Off*
a carriage return control command. « On

* Factory default
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USB menu

Use the USB menu to change printer settings on jobs sent through a Universal Serial Bus (USB)

port.

Setting
NPA Mode

Send print jobs to the printer and query
printer status information e On
simultaneously.

Use this setting to: Values

Off

* Factory default

¢ Auto*
MAC Binary PS | Configure the printer to process « Off—The printer filters PostScript print jobs
Macintosh binary PostScript print jobs. using standard protocol.

e On—The printer processes raw binary
PostScript print jobs from computers using the
Macintosh operating system. This setting often
causes Windows print jobs to fail.

e Auto*—The printer processes print jobs from
computers using either Windows or Macintosh
operating systems.

Utilities menu

Use the Utilities menu to troubleshoot printer problems.

Setting

Reset Factory

Use this setting to: Values

Return your printer settings to the factory default values. Sometimes resetting the printer

Defaults to the original settings solves formatting problems. All menu items are reset to the
factory default values except:
« Display Language.
« All settings in the Parallel menu, Network menu, LocalTalk menu, and USB menu.
All downloaded resources (fonts, macros, and symbol sets) in printer memory (RAM) are
deleted. Resources in flash memory are unaffected.
Reset Return the photoconductor counter to zero.
(F;gatrﬂztr)nductor The replace photoconductor message should be cleared only when the photoconductor
kit has been replaced.
Hex Trace Help isolate printing problems when unexpected characters print or » Off*
characters are missing. Hex Trace helps you determine if there is a e On

problem with the language interpreter or the cable by telling you what
information your printer is receiving. To exit Hex Trace, turn off the printer.

Print Quality Test
Pages

* Factory default

Help isolate print quality problems, such as streaking. When you select this setting, three
pages print to help you evaluate print quality:

« A text page with printer information, cartridge information, current margin settings,
and a graphic.
< Two pages with graphics.
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0 Software and network tasks
ﬁ

Section Page
How to install drivers for local printing 87
How to print the menu settings and network setup pages 92
How to print a test page 92
How to configure for TCP/IP 93
How to set up the printer for network printing 94
Using the printer resident Web page 100
Using the Local Printer Setup Utility 101
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How to install drivers for local printing
A local printer is a printer attached to your computer using a USB or parallel cable. The printer driver
is software that lets your computer communicate with your printer.

The procedure to install drivers depends on the operating system you are using. Use the following
table to find driver installation instructions for your particular operating system. If you need additional
help, refer to the documentation that shipped with your computer and your software.

Operating system Go to page...

Windows 87
Macintosh 89
UNIX/Linux 91
Windows

Some Windows operating systems may already include a printer driver that is compatible with your
printer. This may mean that installation will seem automatic in later versions of Windows. System
printer drivers work well for simple printing, but they contain less functionality than our enhanced
custom printer driver.

Installing a custom driver does not replace the system driver. A separate printer object is created and
appears in the Printers folder.

Use the drivers CD that shipped with your printer to install the custom printer driver and obtain all the
enhanced printer features and functionality.

Using Windows Server 2003, Windows 2000, Windows XP, and Windows 98/Me

1 Insert the drivers CD.

If the CD does not auto launch, click Start > Run, and then type D: \ Set up. exe in the Run
dialog box.

2 Click Install Software.

Note: Some Windows operating systems require that you have administrative access to
install printer drivers on your computer.

Click Printer and Software.
Click Agree to accept the license agreement.
Select Suggested, and then click Next.

Select Local Attached, the printer manufacturer, and then click Next.

~N o 0o b~ W

Follow the instructions on your screen to complete installing the drivers.
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Using Windows 95, Windows NT
1 Insert the drivers CD.
Note: USB support is not available for Windows 95 or Windows NT operating systems.

If the CD does not auto launch, click Start > Run, and then type D: \ Set up. exe in the Run
dialog box.

2 Click Install Software.

3 Click Printer and Software.
Note: You may need administrative access to install printer drivers on your computer.

4 Click Agree to accept the license agreement.
5 Select Custom, and then click Next.

6 Follow the instructions on your screen to complete installing the drivers.
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Macintosh
Macintosh OS 8.6 or later is required for USB printing. To print locally to a USB-attached printer, you

must create a desktop printer icon (Macintosh 8.6—9.x) or create a queue in Print Center
(Macintosh OS X).

Creating a desktop printer icon (Macintosh 8.6—-9.x)

1 |Install a printer PostScript Printer Description (PPD) file on your computer.
a Insert the drivers CD.

b Double-click Classic, and then double-click the installer package for your printer.

Note: A PPD file provides detailed information about the capabilities of a printer to your
Macintosh computer.

Choose the language you want to use, and then click OK.

o O

Click Accept after you read the license agreement.
e Click Continue after you finish with the Readme file.
f Choose a default paper size.

g Onthe Easy Install screen, click Install. All the necessary files are installed on your
computer.

h  Click Quit when installation is complete.
2 Do one of the following:
Macintosh 8.6—9.0: Open Apple LaserWriter.
Macintosh 9.1-9.x: Open Applications, and then click Utilities.
3 Double-click Desktop Printer Utility.
4 Select Printer (USB), and then click OK.
5 Inthe USB Printer Selection section, click Change.

If your printer does not appear in the USB Printer Selection list, make sure the USB cable is
properly connected and the printer is turned on.

6 Select the name of your printer, and then click OK. Your printer appears in the original Printer
(USB) window.

7 In the PostScript Printer Description (PPD) File section, click Auto Setup. Make sure your
printer PPD now matches your printer.

8 Click Create, and then click Save.

9 Specify a printer name, and then click Save. Your printer is now saved as a desktop printer.

Software and network tasks
89



Creating a queue in Print Center (Macintosh OS X)

1

Install a printer PostScript Printer Description (PPD) file on your computer.

a

b

o O

Insert the drivers CD.

Double-click Mac OS X, and then double-click the installer package for your printer.

Note: A PPD file provides detailed information about the capabilities of a printer to your
Macintosh computer.

On the Authorization screen, choose Click the lock to make changes.

Enter your password, and then click OK.

Click Continue on the Welcome screen and again after you view the Readme file.
Click Agree to accept the license agreement.

Select a Destination, and then click Continue.

On the Easy Install screen, click Install. All the necessary files are installed on your
computer.

Click Close when installation is complete.

Open Finder, click Applications, and then click Utilities.

Double-click Print Center.

Do one of the following:

If your USB-attached printer appears in the Printer List, you can quit Print Center. A queue
has been created for your printer.

If your USB-attached printer does not appear in the Printer List, make sure the USB cable is
properly connected and the printer is turned on. After the printer appears in the Printer List,
you can quit Print Center.
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UNIX/Linux

Local printing is supported on many UNIX and Linux platforms, such as Sun Solaris and Red Hat.

Note: If your drivers CD does not contain any UNIX/Linux printer driver packages, contact
the place you purchased your printer to see if your printer is supported.

Some printer driver packages are available on the drivers CD. The User’s Guide in each package
gives detailed instructions for installing and using printers in UNIX and Linux environments.

All the printer driver packages support local printing using a parallel connection. The driver package
for Sun Solaris supports USB connections to Sun Ray appliances and Sun workstations.
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How to print the menu settings and network setup pages

To print the menu settings page and network setup page, press the Continue <D button from the
Ready state.

e On the menu settings page:
— Verify that the options you installed are correctly listed under “Installed Features.”

If an option is not listed under Installed Features, turn off the printer, unplug the power
cord, and reinstall the option.

— Verify the amount of memory installed is correctly listed under “Printer Information.”
— Verify that the paper trays are configured for the sizes and types of paper you loaded.

e On the network setup page, confirm that Status is “Connected.”

If Status is “Not Connected,” your LAN drop may not be active or your network cable may be
malfunctioning. Consult your network support person for a solution, and then print another
network setup page to verify that you are connected to your network.

How to print a test page

1 Click Start - Settings - Printers.
2 Select your printer.

3 Click File > Properties.

4  Click Print Test Page.

Macintosh

1 From the desktop, double-click your printer icon.
2 Double-click <printer name> Utility.

3 Click the Print a Test Page button.
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How to configure for TCP/IP

If you have TCP/IP available on your network, we recommend that you assign an IP address to the
printer.

Assigning a printer IP address

If your network is using DHCP, an IP address is automatically assigned after you connect the network
cable to the printer.

1 Look for the address under the “TCP/IP” heading on the network setup page you printed in
“How to print the menu settings and network setup pages” on page 92.

2 Goto “Verifying the IP settings” on page 93 and begin with step 2.
If your network is not using DHCP, then you must manually assign an IP address to the printer.
An easy way to do this is to use the Print Server TCP/IP Setup Utility.

Detailed instructions about installing and using this utility are located on the drivers CD that shipped
with your printer. Launch the CD, click View Documentation and then Network Printer Install. Look
for information about using the Print Server TCP/IP Setup Utility.

To use this utility, you will need to know the printer's 12-digit physical address or Universally
Administered Address (UAA). Look for the UAA entry on the network setup page you printed earlier.
You can use either the MSB or canonical form of the UAA.

Verifying the IP settings
1 Print another network setup page. Look under the “TCP/IP” heading and make sure the IP
address, netmask, and gateway are what you expected.

See “How to print the menu settings and network setup pages” on page 92 if you need
help.

Note: To display a command prompt on a Windows computer, click Start > Programs >
Command prompt (or Accessories > Command prompt if using
Windows 2000).

2 Ping the printer and verify that it responds. For example, at a command prompt on a network
computer type pi ng followed by the new printer IP address (for example, 192. 168. 0. 11):

If the printer is active on the network, you will receive a confirmation.
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How to set up the printer for network printing

After you have assigned and verified the TCP/IP settings (see “How to configure for TCP/IP” on
page 93), you are ready to install the printer drivers on each network computer.

Windows

In Windows environments, network printers can be configured for direct printing or shared printing.
Both network printing methods require the installation of a printer driver and the creation of a network

printer port.
Supported printer drivers

e Windows system printer driver
e Custom printer driver

System drivers are built into Windows operating systems. Custom drivers are available on the drivers

CD.

Supported network printer ports

e Microsoft IP port—Windows NT 4.0, Windows 2000, Windows XP, and Windows Server 2003
e Printer network ports—Windows 95/98/Me, Windows NT 4.0, Windows 2000, Windows XP,

and Windows Server 2003

For basic printer functionality, you can install a system printer driver and use a system network
printer port, such as an LPR or a Standard TCP/IP port. The system printer driver and port let you
maintain a consistent user interface for use with all the printers on your network. However, using a
custom printer driver and network port provides enhanced functionality, such as printer status alerts.

Follow the steps for your printing configuration and operating system to configure your network

printer:

Printing configuration

Operating system

Go to page...

Printer is connected to one of the computers on the network using a
local cable, such as USB.

Printer drivers are installed on the computer attached to the printer.

During driver installation, the printer is set up to be “shared” so that
other network computers can print to it.

Direct Windows 95/98/Me, 95
Printer is connected directly to the network using a network cable, Windows NT 4.0,
such as Ethernet Windows 2000,

: Windows XP, or
Printer drivers are typically installed on each network computer. Windows Server 2003
Shared Windows NT 4.0, 95

Windows 2000,
Windows XP, or
Windows Server 2003
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Direct printing using Windows 95/98,Me, Windows NT 4.0, Windows 2000,
Windows XP, and Windows Server 2003

To install a custom printer driver and network port:

[ERN
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10
11

12
13

Launch the drivers CD.

Click Install Printer and Software.

Click Printer.

Click Agree to accept the license agreement.
Select Quick install, and then click Next.

Click Create new port.

Click Add Port.

Select TCP/IP Network Port, and then click Add.
Enter the information to create the port.

a Assign a logical port name.

This can be any name that you associate with the printer, such as Col or 1- | ab4. After the
port is created, this name appears in the list of available ports on the Method of Connection
screen.

Note: If you don’t know the IP address, print a network setup page and look under the
TCP/IP heading. For help, see “How to print the menu settings and network
setup pages” on page 92.

b Enter the IP address in the text box.
¢ Click Add Port.
Click Done until you return to the Method of Connection screen.

Select the newly-created port from the list, and then select the model and manufacturer (if
available) of the printer you want to install.

Click Finish to complete the installation.

Print a test page to verify printer installation (see “How to print a test page” on page 92).

Shared printing from a server using Windows NT 4.0, Windows 2000, Windows XP,
and Windows Server 2003

After connecting your printer to a Windows NT 4.0, Windows 2000, Windows XP, or
Windows Server 2003 computer (which will act as a server), follow these steps to configure your
network printer for shared printing:
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Step 1: Install a custom printer driver

1
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Insert the drivers CD.

If the CD does not auto launch, click Start > Run, and then type D: \ Set up. exe in the Run
dialog box.

Click Install Software.

Click Printer and Software.

Click Agree to accept the license agreement.

Select Suggested, and then click Next.

Select Local Attached, the printer manufacturer, and then click Next.
Follow the instructions on your screen to complete installing the drivers.

Print a test page to verify printer installation (see “How to print a test page” on page 92).

Step 2: Share the printer on the network

a b W DN

Click Start > Settings > Printers.

Select the printer you just created.

Click File > Sharing.

Check the Shared check box, and then enter a name in the Shared Name text box.

In the Alternate Drivers section, select the operating systems of all the network clients that
will print to the printer.

Click OK.

Note: If you are missing files, you may be prompted to provide the server operating
system CD.

Check the following to make sure the printer was successfully shared.

* The printer object in the Printers folder now has a shared indicator. For example, in
Windows NT 4.0, a hand appears under the printer object.

e Browse Network Neighborhood. Find the host name of the server and look for the shared
name you assigned to the printer.

Step 3: Install the printer driver (or subset) on network clients

Using the point and print method

Note: This method is usually the best use of system resources. The server handles driver
modifications and the print job processing. This lets network clients return to
programs much faster.
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With this method, a subset of driver information is copied from the server to the client computer. This
is just enough information to send a print job to the printer.

1

2
3
4

5
6

On the Windows desktop of the client computer, double-click Network Neighborhood.
Locate the host name of the server computer, and then double-click the host name.
Right-click the shared printer name, and then click Install.

Wait a few minutes for the driver information to be copied from the server computer to the
client computer, and for a new printer object to be added to the Printers folder. The time this
takes varies based on network traffic and other factors.

Close Network Neighborhood.

Print a test page to verify printer installation (see “How to print a test page” on page 92).

Using the peer-to-peer method

With this method, the printer driver is fully installed on each client computer. Network clients retain
control of driver modifications. The client computer handles the print job processing.

1

2
3
4

Click Start > Settings > Printers.
Click Add Printer to launch the Add Printer wizard.
Click Network Print Server.

Select the network printer from the Shared printers list. If the printer is not listed, enter the
path of the printer in the text box.

The path will look similar to the following:

\\ <server host name>\<shared printer nane>

Note: If this is a new printer, you may be prompted to install a printer driver. If no system
driver is available, then you need to provide a path to available drivers.

The server host name is the name of the server computer that identifies it to the network. The
shared printer name is the name assigned during the server installation process.

Click OK.

Select whether you want this printer to be the default printer for the client, and then click
Finish.

Print a test page to verify printer installation (see “How to print a test page” on page 92).
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Macintosh

Note: A PostScript Printer Description (PPD) file provides detailed information about the
capabilities of a printer to your UNIX or Macintosh computers.

To print to a network printer, each Macintosh user must install a custom PostScript Printer
Description (PPD) file and either create a desktop printer on the computer (Mac OS 8.6 to 9.x) or
create a print queue in Print Center (Mac OS X). Follow the instructions for your operating system.

Mac OS 8.6 to 9.x

Step 1: Install a custom PPD file

a h~h W N

Note: Installing the custom PPD is required only if this is the first time the printer has been
set up. If the printer was previously installed, go on to Step 2: Create a desktop
printer.

Insert the drivers CD.

Double-click Classic.

Double-click the Installer icon.

Select the language of your operating system, and then click OK.

Click Install to install the PPD file for your printer.

Step 2: Create a desktop printer

I
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In the Chooser, select the LaserWriter 8 driver.

If you have a routed network, select the default zone from the list. If you don’t know which
zone to select, look on the Network Setup page under AppleTalk for Zone.

Select the new printer from the list.

If you don’t know which printer to select, look on the Network Setup page under the AppleTalk
heading to find the default name of the printer.

Click Create.

Make sure there is an icon next to the printer name in the Chooser.
Close the Chooser window.

Verify printer installation.

a Click the desktop printer icon you just created.

b Choose Printing - Change Setup.
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« If the PPD file displayed in the PostScript Printer Description (PPD) file portion of the
menu is correct for your printer, then printer setup is complete.

« If the PPD file displayed in the PostScript Printer Description (PPD) file portion of the
menu is not correct for your printer, repeat “ Step 1: Install a custom PPD file” on
page 98.

Mac OS X version 10.1.2 and later

Step 1: Install a custom PPD file

1
2

3

Insert the drivers CD.
Click Mac OS X > <language>.
For example, Mac OS X - English.

Double-click the installer icon for your printer to run the installer.

Step 2: Create a print queue in Print Center

A WDN

Click Applications > Utilities &> Print Center.
Click Add Printer.
Choose AppleTalk as your method of connection.

If you have a routed network, select the zone from the list. If you don’t know which zone to
select, look on the Network Setup page under AppleTalk for Zone.

Select the new printer from the list, and then click Add.
Note: If you don’t know which printer to select, look on the Network Setup page under the
AppleTalk heading to find the default name of the printer.
Verify printer installation:
a Click Applications > TextEdit.

b Choose File > Print > Summary. The Summary window shows the PPD installed for
your printer.

« If the PPD file displayed in the Summary window is correct for your printer, then
printer setup is complete.

« If the PPD file displayed in the Summary window is not correct for your printer, delete
the print queue from Print Center and repeat Step 1: Install a custom PPD file.
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UNIX/Linux

Your printer supports both UNIX and Linux network environments.

For the latest information about installing a network printer in a UNIX or Linux environment, click
View Documentation on the drivers CD.

NetWare

Your printer supports both Novell Distributed Print Services (NDPS) and regular queue-based
NetWare environments. For the latest information about installing a network printer in a NetWare
environment, launch the drivers CD and click View Documentation.

Using the printer resident Web page

If you have a network model, your printer has a resident Web page, which you can access from your
browser. To access the resident Web page, type the printer’s IP address in the URL address field of
your browser (for example, http://192.168.236.24). If you do not know the IP address of your printer,
you can find it on the network setup page (for help, see “How to print the menu settings and network
setup pages” on page 92).

Some of the resident Web page features include a real-time status window of the printer and details
of the printer's configuration, such as current memory and engine code levels. If you have
administrative rights, you can also change printer settings.
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Using the Local Printer Setup Utility

The Local Printer Setup Utility, located on the drivers CD, lets you change printer settings not
available from your printer driver (for example, activating Alarm Control if you want the printer to
sound an alarm when it needs attention).

Click View Documentation on the drivers CD for instructions on installing and using the Local
Printer Setup Utility on your computer.

You can change the following settings using the Local Printer Setup Utility:

Finishing Settings

* Duplex

e Duplex Bind

» Copies

» Blank Pages

» Collation

» Separator Sheets
» Separator Source
* Multipage Print
» Multipage Order
* Multipage View
» Multipage Border

PostScript Settings

» Print PS Error
» Font Priority

Paper Settings

» Paper Source
« Paper Size"

» Paper Type*

e Custom TypesT

» Substitute Size
» Configure MP

« Paper Texture*
. PaperWeight*t
« Paper Loading*

Quality Settings
* Print Resolution
» Toner Darkness
« PQET

* PictureGrade™

Parallel Settings

¢ PCL SmartSwitch
* PS SmartSwitch
» Parallel Buffer

* Advanced Status
¢ Honor Init

Setup Settings

» Printer Language
¢ Power Saver

« Resource Save
« Download Target
* Print Timeout

* Wait Timeout

¢ Auto Continue

¢ Jam Recovery

* Page Protect

* Print Area

« Display Language
* Alarm Control

* Toner Alarm

PCL Emulation Settings

» Orientation
e Lines Per Page
* A4 Width

o Tray Renumber”

» Auto CR after LF
e Auto LF after CR

USB Settings

* PCL SmartSwitch
* PS SmartSwitch
» USB Buffer

* Per supported sources

T Per custom type number
* Per supported media
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What supplies do | need and how do | order them?

There are only two supply items that have to be replaced on a regular basis: the toner cartridge and
the photoconductor kit, which together comprise the print cartridge assembly. The photoconductor kit
typically lasts up to 30,000 pages (at approximately 5% coverage), whereas the toner cartridge has
to be replaced more frequently. How often the toner cartridge needs replacing depends on which
cartridge you purchase and the average amount of toner coverage you have on your print jobs.

To order supplies, contact the place where you bought your printer.

Storing supplies

Choose a cool, clean storage area for your printer supplies. Store supplies right side up in their
original packaging until you are ready to use them.

Do not expose supplies to:

» Direct sunlight

* Temperatures above 35°C (95°F)
e High humidity (above 80%)

e Salty air

e Corrosive gases

e Heavy dust

How to conserve supplies

Conserving supplies lowers printing costs.

* When printing drafts, conserve toner by changing the Toner Darkness setting in your printer
driver. The settings range from 1 (very light) to 10 (very dark), with 8 being the default. Setting
the Toner Darkness to 1 conserves the most toner.

* Reduce paper consumption by printing on both sides of the paper.
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How to know when you need new supplies

The following sections describe a couple ways to determine when new supplies are needed.

Checking the toner and photoconductor levels

You can determine approximately how much toner is left in your cartridge and how full the
photoconductor kit is by printing out a menu settings page. This helps you decide when you might
need to order replacement supplies. For help printing a menu settings page, see “How to print the
menu settings and network setup pages” on page 92.

Also, the Toner low light sequence (see page 61) is displayed when the toner cartridge is nearly
empty. You can still print for a short time while this sequence is displayed, but print quality begins to
decrease as the toner level decreases.

To ensure print quality and to avoid damage to the printer, the printer stops operating after the
photoconductor kit has reached a maximum of 40,000 pages. (See “ Replace photoconductor kit
(printer hard stop)*” on page 105 for the light sequence associated with this stop.) The printer
automatically notifies you before the photoconductor reaches this point. To avoid having the printer
stop operating, replace the photoconductor kit when you first receive the “Replace photoconductor
kit” light sequence.

While the printer may continue to function properly after the photoconductor kit has reached its
official end-of-life (approximately 30,000 pages), print quality begins to significantly decrease until
the photoconductor stops operating at the maximum of 40,000 pages.
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Recognizing the operator panel light sequences

The operator panel displays certain light sequences to let you know when the toner level is low or
when it's time to replace the photoconductor Kit.

Printer condition Toner low Photoconductor Replace Replace
kit near full photoconductor | photoconductor
kit kit
(printer hard
stop)*
For more information, see page: 61 62 62 63

Continue

Toner Low/ - N
Replace PC Kit b o b o . 4

Load Paper

Paper Jam

* |f the operator panel lights display this sequence, the printer will not print
any more jobs until the photoconductor kit is replaced.

Note: The operator panel may also display other light sequences in conjunction with the
“Toner low” and “Replace photoconductor kit” lights.
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How to change a toner cartridge

Warning: When replacing a toner cartridge, do not leave the new cartridge exposed to direct
light for an extended period of time. Extended light exposure can cause print quality
problems.

1 Open the front cover by pressing the button on the left side of the printer and lowering the
cover.
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2 Remove the toner cartridge:
a Press the button on the base of the print cartridge assembly.

b Pull the toner cartridge up and out using the handle.

3 Unpack the new toner cartridge.

4 Rotate the cartridge in all directions to distribute the toner.
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5 Install the new toner cartridge by aligning the white rollers on the toner cartridge with the
white arrows on the tracks of the photoconductor kit and pushing the toner cartridge in as far
as it will go. The cartridge clicks into place when correctly installed.

6 Close the front cover.

Refilled toner cartridge notice

The use of third-party remanufactured cartridges is not recommended. The print quality and
reliability of a toner cartridge cannot be guaranteed after it has been refilled. A substantial reduction
in photoconductor kit life is also likely if refilled toner cartridges are used.

Warning: Toner cartridge leaks due to refilling can cause failure in several areas of your
printer.
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How to change a photoconductor kit

Warning: When replacing a photoconductor kit, do not leave the toner cartridge or the new
photoconductor kit exposed to direct light for an extended period of time. Extended
light exposure can cause print quality problems.

1 Open the front cover by pressing the button on the left side of the printer and lowering the
cover.
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2 Pull the print cartridge assembly out of the printer by pulling on the toner cartridge handle.

Note: Do not press the button on the print cartridge assembly.

Place the print cartridge assembly on a flat, clean surface.
3 Remove the toner cartridge:
a Press the button on the base of the print cartridge assembly.

b Pull the toner cartridge up and out using the handle.

4 Unpack the new photoconductor Kkit.
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5 Install the toner cartridge into the new print cartridge assembly by aligning the white rollers on
the toner cartridge with the white arrows on the tracks of the photoconductor kit and pushing
the toner cartridge in as far as it will go. The cartridge clicks into place when correctly

installed.

6 Install the print cartridge assembly into the printer by aligning the green arrows on the guides
of the print cartridge assembly with the green arrows on the tracks in the printer and pushing

the print cartridge assembly in as far as it will go.

7 Close the front cover.

Note: For information about resetting the photoconductor kit's counter, refer to the
instruction sheet that shipped with the new Kkit.
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General problems

Problem / Question Solution / Answer

What do the blinking
lights mean?

See “Understanding the operator panel lights” on page 50 for information about
what each light pattern means.

Why am | missing
characters when | print
on envelopes?

If you see voids (missing characters) when printing envelopes, check your printer
driver settings to make sure you selected Envelope from the Paper Type menu.

If Envelope is already selected, try changing the texture setting to a rougher setting.
Sometimes toner does not adhere well to smooth-textured envelopes. From your
printer driver, select Custom 6-Rough Env from the Paper Type menu.

To change Custom 6 back to its default settings for Paper Type, Paper Texture, and
Paper Weight, use the Local Printer Setup Utility on the drivers CD that shipped with
your printer. If you already installed the printer drivers and utilities, skip to step 7.

1 Insert the drivers CD into your computer.

Click Printer Software.

Click Agree.

Select Local Printer Install, and then click Next.

Select your printer and port, and make sure Local Printer Setup Utility is
checked.

6 Click Finish.

The Utility will be installed on your computer under Program Files (unless you
chose a different directory).

7 Open the Local Printer Setup Utility.

8 From the Paper Menu, scroll through the menu items until you see the Custom
menu setting.

9 Click Custom.
10 Scroll down to Custom 6 Paper Type.

11 Select envelope for the Custom 6 paper type, heavy for the Custom 6 paper
weight, and rough for the Custom 6 paper texture.

12 From the toolbar, click Actions.
13 Click Apply to save the changes you made.
14 Click File > Exit to close the Local Printer Setup Utility.

g b WON

How do | clear a paper
jam?

See “How to clear paper jams” on page 24 for information about clearing jams.

The toner low light
sequence is on, but |
don’t have another
cartridge to put in yet.
Can I still print with the
low cartridge?

Yes, you can still print. To extend the life of you toner cartridge somewhat, remove
the cartridge, rotate it in all directions to distribute the toner, then insert it back into
the printer.

When the toner low light sequence is first displayed, you should still be able to print
approximately 1200 pages, based on approximately 5% coverage of pages.

The printer seems to
print slower when using
the manual feeder.

This is normal. The printer sometimes prints at a slightly slower speed when feeding
print media from the manual feeder.
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Problem / Question

Solution / Answer

| want to manually
duplex card stock, but
I’'m having trouble
getting it to feed.

The problem is that when the printer tries to manually duplex a print job, it always
prints side 2 from Tray 1. However, Tray 1 does not support card stock.

To achieve the desired effect, you have to send both pages of the print job as
separate jobs. After the first page has printed, reload the card stock in the manual
feeder. Load the card stock in the feeder with the already-printed side down, with the
top of the sheet first.

Paper stacks poorly in
the output bin.

Extend the
paper support
on the output
bin.

Dust is gathering on the
paper tray when it is
extended.

The paper tray is getting
bumped and pushed out
the front of the printer
when it is extended.

Attach the dust cover to the back of the printer. This protects the paper tray from the
environment as well as keep the tray from being knocked out of position while it is
extended.

See Attaching the dust cover for information about attaching the dust cover.
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Print quality problems

You can solve many print quality problems by replacing a supply or maintenance item that has
reached the end of its intended life. Use the following table to find solutions to print quality problems.

Symptom Cause Solution
White lines » The printhead lens is dirty. Try the following in this order:
. Either_ the toner cartridge orthe |1 Clean the printhead lens.
fuser is defective. (See “How to clean the
Al'CDE printhead lens” on page 119.)

2 Replace the toner cartridge.

AlCDE
AlCDE

3 Replace the fuser’.

Streaked horizontal lines The toner cartridge or fuser may Replace the toner cartridge or
be defective, empty, or worn. fuser” as needed.

ABCDE
ABeDE
ABCDE

Streaked vertical lines » Toner is smeared before fusing |« If paper is stiff, try feeding from
to the paper. another tray or the manual
« The toner cartridge is defective. feeder.
DE ¢ Replace the toner cartridge.

DE
A CWE

Print irregularities e Paper has absorbed moisture e Load paper from a fresh
due to high humidity. package in the paper tray.
* You are using paper that does » Avoid textured paper with rough
ARCDE not meet the printer finishes.
specifications. » Make sure the printer driver
ABCI = « The fuser is worn or defective. paperftype setting matches the
type of paper you are using.
AP~ LE - « Replace the fuser”.

" To replace the fuser, call a service technician.

T This setting can be changed using the Local Printer Setup Utility. See
for more information.
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Symptom
Print too light

Cause

The Toner Darkness setting is
too light.

You are using paper that does
not meet the printer
specifications.

The toner cartridge is low on
toner.

The toner cartridge is defective.

Solution

Select a different Toner

Darkness' setting from the
printer driver before sending the
job to print.

Load paper from a new
package.

Avoid textured paper with rough
finishes.

Make sure the paper you load in
the trays is not damp.

Replace the toner cartridge.

Print too dark

The Toner Darkness setting is
too dark.

The toner cartridge is defective.

Select a different Toner

Darkness' setting from the
printer driver before sending the
job to print.

Replace the toner cartridge.

Transparency print quality is
poor

(Print has inappropriate light or
dark spots, toner is smeared, or
horizontal or vertical light bands
appeatr.)

You are using transparencies
that do not meet the printer
specifications.

The Form Type setting in the
printer driver is set to something
other than transparency.

Use only transparencies
recommended by the printer's
manufacturer.

Make sure the Form Type
setting is set to transparency.

Toner specks

The toner cartridge is defective.
The fuser is worn or defective.
Toner is in the paper path.

Replace the toner cartridge.

Replace the fuser’.
Call for service.

Toner rubs off the paper easily
when you handle the sheets

The Paper Texture setting is

wrong for the type of paper or
specialty media you are using.
The Paper Weight setting is

wrong for the type of paper or
specialty media you are using.
The fuser is worn or defective.

Change Paper Texture' from
Normal to Smooth or Rough.

Change Paper WeightJr from
Plain to CardStock (or other
appropriate weight).

Replace the fuser’.

Gray background

ABCDE
ABCDE
ABCDE

The Toner Darkness setting is
too dark.

The toner cartridge is defective.

" To replace the fuser, call a service technician.

T This setting can be changed using the Local Printer Setup Utility. See
for more information.

Select a different Toner

Darkness’ setting from the
printer driver before sending the
job to print.

Replace the toner cartridge.
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Symptom

Uneven print density

ABCDE
ABCDE
ABCDE

Cause

e The toner cartridge is defective.

Solution

» Replace the toner cartridge.

Ghost Images

e The Form Type setting in the
printer driver is set incorrectly.

» Toner level is low in the toner
cartridge.

» Make sure the Form Type
setting is correct for the paper or
specialty media you are using.

» Replace the toner cartridge.

Uneven printing

JE
JE
JE

(Print only appears on one side of
the page.)

» The toner cartridge is not
properly installed.

 Remove and then reinsert the
toner cartridge.

Incorrect margins

The Form Size setting in the
printer driver is different than the
size paper that is loaded in the
tray. For example, you inserted A4
size paper into the selected tray
but did not set the Form Size to
A4,

Set the Form Size to A4.

Skewed print
(Print is inappropriately slanted.)

» The guides in the selected tray
are not in the correct position for
the paper size loaded in the tray.

» The manual feeder’s guides are
not in the correct position for the
paper size loaded in the feeder.

" To replace the fuser, call a service technician.

T This setting can be changed using the Local Printer Setup Utility. See
for more information.

* Move the guides in the tray so
that they are snug against the
sides of the paper.

* Move the manual feeder’s
guides so that they are snug
against the sides of the paper.
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Symptom
Blank pages

Cause

The toner cartridge is defective or
empty.

Solution

Replace the toner cartridge.

Solid black pages

e The toner cartridge is defective.
 Your printer requires servicing.

» Replace the toner cartridge.
 Call for service.

Paper curls badly once it prints
and exits to the bin

The Paper Texture setting is wrong
for the type of paper or specialty
media you are using.

* . . .
To replace the fuser, call a service technician.

T This setting can be changed using the Local Printer Setup Utility. See
for more information.

Change Paper Texture from
Rough to Normal or Smooth.
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How to clean the printhead lens
You can solve some print quality problems by cleaning the printhead lens.

1 Turn the printer off.

2 Open the front cover by pressing the button on the left side of the printer and lowering the
cover.
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3 Remove the print cartridge assembly out of the printer by pulling on the toner cartridge
handle.

Note: Do not press the button on the print cartridge assembly.

Place the print cartridge assembly on a flat, clean surface.

Warning: Do not leave the print cartridge assembly exposed to direct light for an extended
period of time. Extended light exposure can cause print quality problems.
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4 Locate the glass printhead lens, which is located within the recessed area in the top of the
printer.

Printhead lens

t

5 Gently wipe the printhead lens with a clean, dry, lint-free cloth.
Warning: Not using a clean, dry, lint-free cloth may result in damage to the printhead lens.

6 Install the print cartridge assembly into the printer by aligning the green arrows on the guides
of the print cartridge assembly with the green arrows on the tracks in the printer and pushing
the print cartridge assembly in as far as it will go.

7 Close the front cover.

8 Turn the printer on.
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reattaching 42

T

TCP/IP 93

test page 92

toner cartridge
changing 106
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troubleshooting 112
print quality 115
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